18 I Window Display

This chapter explains about “Window Display” in GP-Pro EX, and the basic operations for
placing Windows.
Please start by reading “18.1 Settings Menu” (page 18-2) and then turn to the corresponding

page.
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Settings Menu

18.1 Settings Menu

Creating Windows

Create and register screen contents that will be dis-

played on the Window.
Window Creation Screen
& Setup Procedure (page 18-5)
&~ Details (page 18-4)
~
LEEIREN

Displaying Windows

Active Screen Active Screen | Active Screen
Beep » Wil’l1d0W BEFP »
© 3 [ Call |
[E L || & Setup Procedure (page 18-8)
&~ Details (page 18-7)
Touch and... The Window is called The Window

and displayed. Check disappears.
the Window, touch the
switch again and...

Changing the Displayed Window

(o) (w5

Active Screen 1 Active Screen 1 Active Screen 1

Window Window Window
2 3

& Setup Procedure (page 18-12)

&~ Details (page 18-11)
Address |Value

\ D100 1 | < Display Control
D101 1 | 4Screen No.
D102 | 400

D103 | 300
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Settings Menu

Displaying the Same Window on All Screens

}Even if the screen changei

Active Screen 1 Active Screen 1 Active Screen 2
Beep » Window » Window &
(= 1 1 Setup Procedure (page 18-15)
&~ Details (page 18-14)
Touch and... The Window can be Even if the screen

called and displayed.  changes, the same
Window is displayed.

Changing the Displayed Window on All Screens

Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3
Window Window Window
1 1
/ Address |Value
N D116 1 | <Display Control
Bn; 2(1)0 « Screen No. & Setup Procedure (page 18-18)
D119 | 100 &~ Details (page 18-17)

4 < o
Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3

Window Window Window
2 2 2
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Creating Windows

18.2 Creating Windows
What is a Window?
Normal Active Screen Normal Active Screen
P_rocgass
ewin:
\\//\Ilirxogv Beep
the process. understood!
Screens that are not commonly used can be saved as Window Screens, and then displayed
and hidden with a call button. They are suitable for temporary reference screens or error
screens.
18.2.1  Details

Create and register window screensto display contents as awindow. Up to 2000 window

screens can be registered in asingle project.

~
S Z

LRI

Window Creation Screen

There are two display methods for created windows.

Display Method

Display asalLocal Window

Screen 1 Screen 2 | Window
Window Window 3
1 Window 1
2

Displays the set Window on a single screen.

& «18.3 Displaying Windows” (page 18-7)

Display as a Global Window

(Even if the screen change%

Screen 2

Window
1

/1l

( the window stays. >

Screen 1

1

Displays the Window on all screens.

& «185 Displaying the Same Window on All

Screens” (page 18-14)
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Creating Windows

18.2.2  Setup Procedure

Create a new Window Screen.

1 Select the [Screen (S)] menu - [New Screen (N)] command, or click the B icon.

Mews Screen (M)
Open Screen (2
Close Screen (C)

Screen Information (I
Change View () 3

Template Registration (T}

2 The[New Screen] dialog box will appear. Select [Window] from [Screen Type]. The [Screen
No.] will be automatically allotted in order of registration starting from 1. The screen number
can be changed, but multiple screens can not have the same screen number.

Screen Type IWindow 'l
Screen Mo, I'I 3: g
Title |Untited

Usze Template
Select Template from List
Eecently zed Template

e e Cancel

3 Click [New]. The window screen is displayed.

’§ Base 1 EE Window1 |
R v Do Tor e 20 300
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Creating Windows

4 Adjust the window screen’s size.
When over any of the 4 corners, the cursor shape will changeto L . Drag it to change the

Size.

o Vol

o -

» Please ensure that the Window Screen does not exceed the size of the Base
Screen.

5 Create the screen. The creation method is the same as for a base screen. Save the project and

the Window Screen’sregistration is complete.
After creating the window screen, select the [ Screen (S)] menu - [Close Screen (C)] com-

mand or click = to closethe screen.

» The created Window Screen will be displayed in the [Screen List] window.
Double-click the scaled-down display screen and the screen will open and can be

edited.

Screen List

Screen Type |AII ﬂ

Refine Search
BoREX |2 &Y

4§,
4> Baze Soreen

u':. Window Screen

= E o001 {Untitled:
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Displaying Windows

18.3 Displaying Windows

What is a Local Window?

Screen 1 Screen 2 | Window
Window Window 3
1 Window 1
2

A Window set exclusively for one screen. A maximum of 3 Windows can be displayed at
atime.

18.3.1 Details

Call up a screen registered as a Window on top of an active screen. The running screen will
remain unchanged, and the Window will be displayed temporarily.

Active Screen Active Screen Active Screen
Beep Window Beep
Ca Ca
Touch and... The Window is called The Window disappears.

and displayed. Check the
Window, touch the switch
again and...

» Aswell asusing aswitch to display awindow, a designated address in the
device/PLC can aso be used to turn awindow’s display ON/OFF.

When displaying multiple local windows that overlap on a screen, the window displayed last
displays at the front. The display order can be changed by touching awindow that is covered.

Active Screen 1 Active Screen 1 Active Screen 1 Active Screen 1

I:Window s Window {5/
1 Beep 1 1

O oo O OO
If you display a Window The last displayed Touch the Window in the The rear screen is
when another Window is Window will appear atthe  back and... displayed.

already displayed... front.
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Displaying Windows

18.3.2  Setup Procedure

* Please refer to the settings guide for details.

&~ «18.7 Window Part Settings Guide” (page 18-21)

* For details about placing parts or setting addresses, shapes, colors, and labels,
please refer to the “ Part Editing Procedure”.

&~ “9.6.1 Procedure for Editing a Part” (page 9-36)

Set the window to display when you touch a switch.

Active Screen Active Screen Active Screen
Beep Window Beep
Ga L
Touch and... The Window is called The Window
and displayed. Check disappears.

the Window, touch the
switch again and...

1 Select the [Part (P)] menu - [Window] command or click the B3 icon to place awindow on
the screen. (When displaying in the GP, the area where the window screen is called is shown
by the dotted-line border.)
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Displaying Windows

2 Double-click the placed Window part and the settings dialog box opens.
Select [Activate Switch] from [Window Type].

,i‘_‘: Window
Part D Basic Settings | Suitch Settings |
fw/D_0000 =
Comment ‘window Type Activate Switch =
Window No. 1 = ﬂ

v “window Interchange

Window Screen Mo.

|»

il

Help [H]

Cancel |

3 Set the[Window No.] to “1”. (Or click the scaled-down window to display from the [Win-
dow Screen No.].)

4 On the [Switch Settings] tab, set the switch’s shape, color, and label.

,i‘_‘: Window
Part 1D Basic Settings  Switch Settings ]
w/D_0000 3:
[ Set the Show Windaw switch.
Comment
Switch Label
Font Type |Standard Font ﬂ Label |OM/
OFF
Display ’—L|
Language ASCI
Text Colar /7 -
Select Shape
Switch Color
Border Color  [C7 | Bink |N0ne ﬂ
Display Color ||:| 2 j Blink. |N0ne ﬂ
Pattern | MoPattem =l
Help [H] Cancel
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Displaying Windows

5 Click [OK]. A window with a switch attached is now set.
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Changing the Displayed Window

18.4 Changing the Displayed Window

18.4.1 Details

D101 : D101 :

Active Screen 1 Active Screen 1 Active Screen 1

Window » Window » Window
1 2 3

Address [Value
D100 1 | <Display Control
D101 1 | «Screen No.
D102 | 400
D103 | 300

Multiple Window Screens can be changed and displayed to the specified screen.

+ When an undefined window screen number is designated, the window screen
will not change. The displayed window will also be closed immediately before
the window screen changes.
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Changing the Displayed Window

18.4.2  Setup Procedure

* Please refer to the settings guide for details.
&~ «18.7 Window Part Settings Guide” (page 18-21)

Change the displayed Window Screen according to the value stored in the word address
(D101).

D101 : D101 :

Active Screen 1 Active Screen 1 Active Screen 1

Wlndow Window Window
2 3

Address [Value
D100 1 Display Control
D101 1 Screen No.
D102 | 400

D103 | 300

1 Select the [Part (P)] menu - [Window] command or click the B3 icon to place awindow on
the screen.
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Changing the Displayed Window

2 Double-click the placed Window part and the settings dialog box opens.
Select [Word Action] from [Window Type].

#* Window
Part ID Basic Settings |
fw/D_0000 =
Comment ‘window Type ‘whord Action -
wiindow Control Address [[PLCTID00000 ="
Window 5 pecification ’m
Window No. 1 = ﬂ

Window Screen Mo.

1: Untitled

il

Cancel |

Help (H)

3 Set the word address (D100) which will control the window’s display in [Window Control
Address].

YWindow Control Address [[FLC1Jpo0100 ~|=

4 Select [Address] from [Window Specification] and set the [Data Type] of data that will be
stored in the address.

Wwindow Specification Address ~

Wwindow Mo, |Doooo1

Window Display Poszition

» Coordinats |Dooooz
¥ Coordinate |Doo003
[ata Type Bin ~

5 Click [OK]. The displayed Window Screen is now set up to change according to the value
stored in the address.

If you turn ON Bit 0 of the Window Control Address (D100), the Window is displayed.
When word address D101's val ue changes, the window screen changes. When the value of
word address D102 or D103 changes, the window’s display position is modified.
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Displaying the Same Window on All Screens

18.5

Displaying the Same Window on All Screens

What is a Global Window?

ﬁven if the screen changei ﬁven if the screen changei

Active Screen 1 Active Screen 2 Active Screen 3

Window » Window » Window
1 1 1
Il Il
The window is called The window The window still
and displayed. stays. stays.

A Window which is common to the whole system. It will till be displayed even if the

screen changes.
A maximum of 1 Window can be displayed at atime.

18.5.1 Details

Call up ascreen registered as a Window on top of an active screen. The same Window can be

displayed on all screens.
; Even if the screen changes&

Active Screen 1 Active Screen 1 Active Screen 2
Beep » Window » Window
Ca
Touch and... The Window can be Even if the screen
called and displayed. changes, the same

Window is displayed.

GP-Pro EX Reference Manual 18-14



Displaying the Same Window on All Screens

18.5.2  Setup Procedure

+ Please refer to the settings guide for details.
& “6.13.6 [System Settings Window] Setting Guide B [Main Unit Settings] Settings
Guide” (page 6-90)
* For detailsabout placing switches or setting addresses, shapes, colors, and |abels,
please refer to “ Part Editing Procedure”.
&~ 9.6.1 Procedure for Editing a Part” (page 9-36)

When you touch the switch placed on the base screen, the same Window is displayed on all

Screens.
;Even if the screen changes K
Active Screen 1 Active Screen 1 Active Screen 2
Beep Window Window
Ca
Touch and... The Window can be Even if the screen
called and displayed. changes, the same

Window is displayed.

1 Select the[Project (F)] menu - [ System Settings (C)] option - [Main Unit Settings| command,
or click on the system settings window’s [Main Unit Settings], and select the [Action
Settings)] tab.

bd ain Lnit Settings

Display Settings | Operation Settingd Action Settings [Systemn Area Settings |

—Window Settings

Global Window Operation I Digable = I
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Displaying the Same Window on All Screens

2 Select [Direct] from [Global Window Operation].

Main Unit Settings

—Window Settings
Global Window Operation

Window Screen Mo,

Dizplay Poszition #-Coordinate I32':' 5: g
Dizplay Position v-Coordinate |24|:I 5: g

Display Seftings | Operation Settings  Action Settings | System Area Settings |

=)

3 Set the [Window Screen No.] to “1”, then set the [Display Position X-Coordinate] and [Dis-
play Position Y-Coordinate] of the display position on the base screen where you will display

the window.

The Global Window settings are compl ete.

4 Place the switch used to display the global window on the base screen, double-click it, and

the settings dialog box will open.

« Please do not place overlapping switches when displaying a Global Window.

5 Set the[Bit Address]. Select [#INTERNAL] from [Device/PLC] and designate L S0016's hit O.

Part [

IS L_0oan 3:

Comment

Select Shape |

[ Mo Shape

¥ Switch Feature

Fulti-function List

Bit Switch

Switch Feature | Switch Eommonl Lamp Featurel Caolar | Label | /™ Input Address (Bit) (<]
- - Device/PLC IﬂINTEHNAL 'l
g (& [Ls = ][00t
Bit Switch  'word Screen Back Clr
Switch Chanae —I
7l18]9
Bit &ddress 4|5l &
I ﬂINTEHNl LS0016( {l
[ ] m 1123
Capy from Coppta/\L [ e
LLamp 1] Ent :

Bit &ction

LS 0016 00
—E'L Bit designation (2 digits)
Address No. Area
LS Device

6 Select [Bit Invert] from [Bit Action] and click [OK].
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Changing the Displayed Window on All Screens

18.6 Changing the Displayed Window on All Screens

Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3

18.6.1 Details

Window Window Window
1 1

Address [Value
D116 1 | 4 Display Control
D117 1 | 4Screen No.
D118 | 200
D119 | 100

N D117 :
Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3

Window Window Window
2 2 2

» When an undefined window screen number is designated, the window screen
will not change. The displayed window will aso be closed immediately before
the window screen changes.
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Changing the Displayed Window on All Screens

18.6.2  Setup Procedure

* Please refer to the settings guide for details.

& %6.13.6 [System Settings Window] Setting Guide H [Main Unit Settings] Settings
Guide” (page 6-90)

Change the Global Window Screen according to the value stored in the word address

(eg.: D117).
Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3

Window » Window » Window
1 1 1

Address [Value
D116 1 | <Display Control
D117 1 | «Screen No.
D118 | 200
D119 | 100

4
Even if the screen Even if the screen
changes changes

Active Screen 1 Active Screen 2 Active Screen 3

Window » Window » Window
2 2 2

1 Select the[Project (F)] menu - [ System Settings (C)] option - [Main Unit Settings] command,
or click on the system settings window’s [Main Unit Settings], and select the [Action
Settings] tab.

b ain Lnit 5 ettings

Display Settings | Operation Settingd Action Settings )5ystem Area Settings |

—Window Settings

Global Window Operation IDisabIe VI
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Changing the Displayed Window on All Screens

2 Select [Indirect] from [Global Window Operation].

Indiect |

3 Set the [Data Type] of the address’ data.

4 Select the [System Area Settings] tab.

[FLET]D 00000 P

rds to se 0

|
r
r
r
=5t
ol
r
[T 5g
I~ ol
r
ol
r
r
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Changing the Displayed Window on All Screens

5 Set the device that will use the system areain [System Area Device], and set the allotted top

address (D100) in [System Area Start Address).

Dizplay Settings ] Operation Settings ] Action Settings

Device Settings

Syztem Area Settingz l

|PLCI

Syztem Area Device

System Data Area

=~

[[FLCT 000100

b =4

Syztem Area Start Address
Fead Ares Size

6 Put acheck mark in[Enable System Data Area], then put acheck mark in [Window Control],
[Window Screen No.], and [Window Display Position].

)

( ¥ Enable System Data Area

Select System Data Area ltem

Mo, of “Words to Use 20

Iv Current Screen Mo [1 'woard) [PLCA 000 00
[v Erar Statuz: [1 WWard) [FLC D007 071
[+ Clock Data [Current): [4 Wward) [FLCT D007 02
Iv Status: [1'word) [PLCA D001 06
v Reserved [white]: [1 wWord) [FLC1]D 00107
[v Change-To Screen Mo [1 %Ward) [PLCT]D 00708
Iv Screen Display OMAOFF: [1 Ward) [PLCA 000 09
[v Clock Data [Setting %alue): [4 Word) [PLCA D00 10
[v Control: [1 tiard) [FLCTIDO0714
v Reserved [Read): [1 'wiard) [FLC1DOO115
I+ “window Contral: [1 %ford) [FLET]DO0T1E
v window Screen Mo [1 %ard) [FLCTIDO0117
v “window Display Position: [2 Words) [FLC1 D001 18

The Global Window (Indirect designation) settings are complete.

When bit 0 of the Window Control Address (e.g.: D116) specified in [System Area Device]
turns ON, the Window is displayed. When the Window screen number’s address (e.g.: D117)
value changes, the screen changes. When the value of the display coordinate’s address (e.g.:
X-coordinate is D118, Y-coordinate is D119) changes, the Window’s display position

changes.

« For details about the System Data Area, please refer to the “ GP-Pro EX Device/

PLC Connection Manual”.
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Window Part Settings Guide

18.7 Window Part Settings Guide

The Window part is used to display a Local Window on a Base Screen.
Place aWindow part on the Base Screen and awindow will be called up and displayed in that
location.

Part D Basic Settings |
I\T\u’D_DDDD 3:
Comment “Windaw Type IBit Action 'l

Window Triager Bit Addhess [[PLCT 00000 ==

“windaw Mo, |1 3: g
IV ‘window Interchange [ Continuous Read

Window Screen Mo.

| v

Cancel

\ Help (H) | J

Setting Description

Placed parts are automatically assigned an ID number.

Window ID: WD_#x*xx* (4 digits)

The letter portion is fixed. The number portion can be modified from
0000 to 9999.

Comment The comment for each Part can be up to 20 characters long.

Choose the control method for displaying/erasing the Window.

* Bit Action

The Window display is controlled by a specific bit address turning ON/
OFF.

¥~ “18.7.1 Bit Action” (page 18-22)
Window Type » Word Action
The Window display is controlled by a specific word address.
&~ «18.7.2 Word Action” (page 18-23)
« Activate Switch
The Window display is controlled by touching an exclusive switch.
F~ «18.7.3 Activate Switch” (page 18-25)

Part ID
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Window Part Settings Guide

18.7.1 Bit Action

B Basic Settings

Basic Seftings

Window Type IBit Action 'l
Window Triager Bit Addhess [[PLCT 00000 ==
“windaw Mo, |1 3: g
IV ‘window Interchange [ Continuous Read
Window Screen Mo.
Setting Description

Window Trigger Bit
Address

Specify the bit address which will control the window display.
This can be set to either aPLC address or GP internal device (System Data
Editor).

* When many parts are placed and running from a window, you can
sometimes speed up screen display by designating GP internal device
addresses.

Window No.

Specify the number of the Window Screen you want to display from 1 to 2,000.

Window Interchange

When this check box is checked, and when multiple windows are dis-
played on the screen, the current window display will be moved behind all
other screen windows by touching it.

Continuous Read

Select whether or not to continue reading data from a part (not including
touch input parts) placed on the window, regardless of the window being
displayed/hidden.

When awindow is displayed, the part's Data Display speed isincreased.

* Since even when the window is not displayed, part data specified on the
window and screen isread, so all the other screen display speeds will be
decreased.

» Up to 3 window parts with the [Continuous Read] option (2 if using
Global Windows) can be placed on a single Base screen. When 3
windows are placed, other window parts (windows where [ Continuous
Read] is not set) can not display.

* |f there are windows with the [ Continuous Read] option and windowswithout
the option, windows with the [Continuous Read] option are read firs.

» Even when awindow is not displayed, any scripts set on that window will
executeif the script condition is satisfied. If you do not want it to execute,
make sure the [ Continuous Read] option is not checked.

Window Screen No.

Displays alist of the currently registered Window Screens. Choose a
screen and the [Window Screen No.] will be automatically inputted.
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Window Part Settings Guide

18.7.2 Word Action

B Basic Settings

Basic Seftings

Window Type IWord Action - l
Window Contral Addhess — [[PLC11DO0000 ==
Window 5 pecification IEonstant 'l
“windaw Mo, |1 3: g
Window Screen Mo.
Setting Description

Window Control
Address

Specify the word address which will control the window display.
This can be set to either aPLC address or GP internal device (System
Data Editor).

15 2 1 0
| Reserved (0) | | |

Window Interchange J

0: Interchange enabled
1: Interchange disabled
0 — 1: Display window

» When many parts are placed and running from a window, you can
sometimes speed up screen display by designating GP internal device
addresses.

Window
Specification

Select the method to display the window from [Constant] or [Address].

For [Constant] For [Address]
Word Address Control Address Word Address Control Address
+1 Reserved +1 Window Screen No.
+2 Reserved +2| Display Position (X Coordinate)
+3 Reserved +3| Display Position (Y Coordinate)

» Constant
Directly designate the Window No.

» Address
Four consecutive words are used starting from [Window Control
Address], the Window No. and display position data are stored and des-
ignated indirectly.

5~ « ¢ Address Designation” (page 18-24)

Window No.

Specify the number of the Window Screen you want to display. The
value can be from 1 to 2,000.

Window Screen No.

Displays alist of the currently registered Window Screens. Select a
screen by clicking on it and [Window No.] will automatically be input.
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Window Part Settings Guide

@ Address Designation

window Control Address— {|PLC1]000000 ~|=

Window Specification I.&ddress "I

Window Mo, {Donom

Wwindow Dizplay Position
¥ Coardinate  |DO000Z
Y Coordinate | DO0O003

[ata Type Bin -

Setting Description
. Shows the address ([Window Control Address] + 1) which will store the
Window No.

window screen number you want to display.

Window Display
Position

(X Coordinate/
Y Coordinate)

Displays the address (X Coordinate: [Window Control Address] + 2, Y
Coordinate: [Window Control Address] + 3) which will store the win-
dow’s layout position data.

It stores the coordinate data of the window's top-left corner.

X Coordinate
D

Y Coordinate I

Window

Base Screen

Data Type

Choose the type of data stored in the address from [Bin] or [BCD].

GP-Pro EX Reference Manual
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Window Part Settings Guide

18.7.3  Activate Switch
B Basic Settings

Basic Settings l Switch Settings |

Wwindow Type Activate Switch
tdindow Mo. 1 El: ﬂ

v “Window Interchange

Window Screen Mo

Setting Description

Specify the number of the Window Screen you want to display from 1 to

Window No. 2.000.

When this check box is checked, and when multiple windows are dis-
played on the screen, the current window display will be moved behind
all other screen windows by touching it. When you touch awindow in
the background, it will be moved to the front of the screen.

Window Interchange

Displaysalist of the currently registered Window Screens. Choose a

Window Screen NO. | o een and the [Window Screen NoJ will be automatically inputted.
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Window Part Settings Guide

B Switch Settings

When the [Window Type] is[Activate Switch], adisplay switch that is attached to the Win-
dow Part can be set.

#* Window
Part ID Basic Settings  Switch Settings ]
w/D_0000 3:
[ Set the Show Windaw switch.
Comment
Switch Label
Font Type |Standard Font ﬂ Label |OM/
OFF
Display ’—L|
Language ASCI
Text Colar /7 -
Select Shape
Switch Color
Border Color  [C7 | Bink |N0ne ﬂ
Display Color ||:| 2 j Blink. |N0ne ﬂ
Pattern | MoPattem =l
Help [H] Cancel

Setting

Description

Set the Show
Window switch

Select whether or not to place a switch used exclusively to display/erase
the window. The Switch will automatically be placed in the top-right of
the window. You can moveit by selecting it.

Font Type

Switch
Label

Select the font type that will be displayed on the Switch’s |abel.

 Standard Font
For abit map font, you can choose the magnification level of the letters
height and width. When you magnify/shrink the letters, the outline may
become rough or the letter may appear squished.

* Stroke Font
Thisis an outline font where the ratio of the characters height/width is
fixed. The letterswill have a smooth outline even if you magnify/shrink
them, however, thisfont has alarge size so it can burden the GP.

Display
Language

Select the label’s display language from [ASCII], [Japanese],
[Taiwaneseg], [Chineseg] and [Korean)].

Text Color

Select acolor for the label’s text.

Label

Input the text to display on the Switch.

Continued
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Window Part Settings Guide

Setting Description
Eg:gfr If the Part Shapeis set to have a border, select a color for it.
glsplay Select the Switch’s color.
olor
Pattern Select from the 8 patterns or choose [No Pattern].
Pait If a pattern has been selected, choose a pattern color.
C?)Ioerm The Switch's color will appear as a combination of the [Display Color]

Switch and [Pattern Color].

Color Select whether or not the Part will blink, and the blink speed. You can
choose different blink settings for the [Border Color], [Display Color],
and [Pattern Color].

Blink
 There are cases where you can and can not set Blink depending on the
Main Unit and System Settings' [Color Settings].
& «95.1 Specify Color B Supported Color List” (page 9-33)
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Restrictions for Windows

18.8

Restrictions for Windows

18.8.1

Restrictions for Window Screens

Up to 2,000 Window Screens can be registered.

A window can not be called from another window screen. Neither awindow nor a Special
Data Display [File Manager] can be placed on awindow screen.

When placing a Historical Trend Graph, Data Block Display Graph, Data Display, or Spe-
cia Data Display [Show CSV] on awindow screen, the following restrictions apply.

Historical Trend Graph, Data Block Display Graph

A maximum of 8 Historical Trend Graphs and Data Block Display Graphs can be dis-
played at the same time on a single screen. When you are using a window screen, the
total number of parts that can be displayed on the base screen and window screen
together is 8.

Also, the maximum number of channels (number of lines) that can be displayed on a
single screen is40. When you are using awindow screen, the total number of channels
that can be displayed on the base screen and window screen together is 40. When more
than 40 lines are set up, the 41st and subsequent lines will not function.

Data Display

You cannot input from a popup keypad into a Data Display placed on a Window. To
input datainto a Data Display on a Window, directly place the keypad.

Special Data Display [Show CSV]

You can not edit data. (CSV edit screen will not function.)

When 384 parts are a ready placed on the base screen and window screen combined, addi-
tional placed parts will not function. Parts will become disabled starting with parts placed
on the last displayed window screen.

When more than 512 Moving Mark display positions are on the base screen and window
screen, the 513th on will be disabled. They will become disabled starting with marks
placed on the last displayed window screen.
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18.8.2 Restrictions for Show Window

» Multiple Window parts can be placed on the same Base screen, but a maximum of 3 can
displayed at the same time. In the case of global windows, 1 Global Window and 2 Local
Windows can be displayed simultaneously on a single screen.

For more details, please refer to “ B Displaying multiple Windows on a single screen”

(page 18-30) .
Local Window Local Window
3 3
Local Window
2

Local Window
2
Local Window
1

e Only 1 Global Window can be set in each project.

*  When an undefined registration number is designated, the window will not display.

*  When awindow has been positioned to stick out past its Base Screen, the window will be
automatically adjusted to fit inside the screen.

* A window’s size and display position go in 4 dot increments for the X coordinate and 1
dot incrementsfor the Y coordinate.
When the designated X coordinate position is not a4 dot increment, the left side will auto-
matically be adjusted to display as a4 dot increment.

Base Screen Base Screen

Global Window

1

4 dots 4 dots
Auto correct M

V:Vindo:w

e If multiple devices/PL Cs are connected, only the device/PLC specified in the GP's Sys-
tem Data Areawill be able to display Global Windows.

*  When using a Switch Lamp [Special Switch (Window Display)] to display awindow, if
the Window part specified in [Window D] is saved multiple times on the same screen, the
first registered window will be displayed. All other registered windows will not function.

» Parts on screens that are completely hidden by a displayed window can not be activated
by touch. However, if only aportion of apart is hidden by awindow, the viewable portion
can be activated by touching it.

« Upto 3 window partswith the [Continuous Read] option (2 if using Global Windows) can
be placed on a single screen. When 3 are placed, all other windows without the [Continu-
ous Read] option that are placed on the screen will not function.

» |If [Continuous Read)] is set, even when the window is not displayed, any scripts set on the
window will execute when their condition is satisfied.

If you do not want the scripts to execute, make sure the [Continuous Read] option is not
checked.
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B Displaying multiple Windows on a single screen

In addition to the Global Windows/L ocal Windows (known as a[User Window]) that can be
created, there are also screens that are handled as a system window.

Subject No. of Windows that can be displayed on 1 screen
* Local Window Up to 3 Global Windows/Loca Windows combined can be
 Global Window displayed
f Screen 1 [ Screen 1 )
Local Local
User
. Local
Window Local Window 2
Window 2 Global Local
Window 1 Window 1
* Security Password | You can only display one Special Window.
Inpu'F Screen (™ Local Screen 1 [ Cocal Screen 1 ]
* Detailed Error Window 3 Window 3
W| ndOW Local Local
D Display’ Window 2 Window 2
* aa ISp ay S Local Local _
POp-Up keypad Window 1 Window 1 D?ﬁg?d
. SpeC|a| Data Window
Dl Spl ay | Communication Error XXXX L
[ShOW CSV] ' S Touch the error message to display the error details.
edit screen ) _ _
« Specia Data However, if the maximum number of User Windows are not
Display currently displayed, multiple Special Windows can be dis-
[File Manager] played by using Local Windows.
s\ﬁeglal E] Red border indicates Special Window
indow N\ \
Local Screen 1 Local Screen 1
Window 1 Data Window 1
Display
File Manager File
DR eh Detailed Manager L= taied
Error Error
Window == Window

J

\ J

i

Up to two more Function Windows You can display the File Manager

can be displayed with a Local

Window...

porravT]

« When the Security Password Input Screen is displayed, other
features cannot be displayed in a User Window.

and a Pop-up keypad.

Continued
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Subject No. of Windows that can be displayed on 1 screen
* Security Password | When awindow display with a high-priority function occurs,
Input Screen alower priority window will automatically be closed in order
* Detailed Error to display the new window.
Wi ”do‘f" , Function Priority Order
» DataDisplay’s
Pop-up keypad 1 |Security Password Input Screen
« Specia Data 2 |Detailed I;rror Window
Display « Data Display’s Pop-up keypad
Show CSVT 3 |+ Special Data Display [Show CSV]'’s edit screen
[ ] ow I's » Special Data Display [File Manager]
edit screen
. SpeCIaI Data (™ Local Screen1 | [ Local Screen 1 |
Special Dlsplay Window 3 () Window 3 ()
Window [File Manager] i D
Local ! R Local
Window 1 [<€¥Pad Window 1 [ Detailed
rror
Window
| Communication Error XXXX L
Touch the error message while a The pop-up keypad closes and a
pop-up keypad is displayed and... detailed error window displays.
« A Special Window has a higher priority display function than
a User Window. Therefore if a File Manager (displayed as a
Local Window) overlaps a Detailed Error Window, the File
Manager is hidden under the Detailed Error Window.
: Sgr?rrlel\r/l Al armge These windows will be displayed regardless of the display
System M e status of the User Windows/Special Windows. Because these
Window | Sy sts Eemifg Menu are independent windows used by the system, there is no dis-
.+ Japanese keypad play limit.
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